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Introduction

Thank you for usingHL-G2 Configuration Tool.
This User's Manual explains how to set up and operate the HL-G2 Configuration Tool
software, which is used in combination with the HL-G2 series laser displacement sensor.
Before using this product, read and understand this User's Manual. Use the product correctly
and in the optimum manner.
Keep this manual in a safe location for reference whenever necessary.

■ Copyright
The copyright of this manual is owned by Panasonic Industrial Devices SUNX Co., Ltd.
Unauthorized reproduction of this manual is strictly prohibited.

■ Trademarks and registered trademarks
● Windows is a registered trademark or trademark of Microsoft Corporation in the United

States and/or other countries.
● Intel(R)Core™is a registered trademark or trademark of Intel Corporation and its subsidiaries

in the United States and/or other countries.
● Ethernet is a registered trademark of FUJIFILM Business Innovation Corp.
● EtherNet/IP™ is a registered trademark of Open DeviceNet Vendors Association (ODVA).
● Modbus is a registered trademark of Schneider Electric USA Inc.
● SLMP is a registered trademark of Mitsubishi Electric Corporation.
The ownerships of all other trademarks belong to their respective owners.

Types of Manuals

● There are different types of user’s manual for theHL-G2series, as listed below. Refer to the
appropriate manual according to your need.

● These manuals can be downloaded from our website:https://industrial.panasonic.com/ac/j/
dl_center/manual/.

Type of sensor / Software
name

Manual name Manual code

Communication type HL-G2
HL-G2 Series User’s Manual
(Communication Type)

WUME-HLG2CM

Analog output type HL-G2
HL-G2 Series User’s Manual
(Analog Output Type)

WUME-HLG2AN

Tool software for the HL-G2
series
HL-G2 Configuration Tool

HL-G2 Configuration Tool User’s Manual WUME-HLG2CT
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Manual Structure

"1 Before Using This Product" Explains the icons used in this document, as well as the software license
agreement

"2 System Configuration" Explains the system configuration diagram and system requirements

"3 Preparing HL-G2
Configuration Tool"

Explains how to make preparations to use HL-G2 Configuration Tool and
how to uninstall the software

"4 Name and Function of Each
Window"

Explains the windows and functions of HL-G2 Configuration Tool

"5 Configuring Sensor Settings" Explains how to set up sensors using HL-G2 Configuration Tool

"6 Setting up Ethernet
Communication"

Explains how to set up Ethernet communication using HL-G2 Configuration
Tool

"7 Using Convenient Functions" Explains convenient functions for the use of HL-G2 Configuration Tool

"8 Troubleshooting" Explains error messages and alarm messages, as well as action methods.

Network Security

This unit may suffer from the following damage during use when connected to the network.
1. Information leakage through this unit
2. Illegal operations of this unit by a malicious third party
3. Obstructing or stopping this unit by a malicious third party
To prevent such damage, you are responsible for taking sufficient network security measures
including the following:
● Make sure that the PC connected to this unit is periodically checked against infection by

computer viruses and malware and then disinfected.
● Use this unit in an environment where a VPN (Virtual Private Network) or leased line network

is established.
● Use this unit in an environment where only limited authorized personnel are allowed to enter.
● Use the PC connected to this unit under secure conditions.
When this unit is connected to an existing LAN, incorrect settings may cause malfunction of
devices on the network. Before connecting the unit to an existing LAN, consult your network
administrator.
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1.1 Description of Icons Used in this Document

■ In this manual, the following symbols are used to indicate safety information that
must be observed.

Indicates an action that is prohibited or a matter that requires caution.

Indicates an action that must be taken.

Indicates supplemental information.

Indicates details about the subject in question or information useful to remember.

Indicates operation procedures.

1.1 Description of Icons Used in this Document
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1.2 Software License Agreement

Panasonic Industrial Devices SUNX Co., Ltd. (“PIDSX”) grants to you a license to use this
Software on condition that you accept this Agreement. You must read this Software License
Agreement (this “Agreement”) carefully before using this Software. Only in case that you accept
this Agreement, you may start your use of this Software.
Your unsealing the package of this Software, or your downloading, installing or launching this
Software or the like shall be deemed as your acceptance of this Agreement.
The Software includes not only proprietary computer programs owned by or licensed by PIDSX
but also open source software programs. As for the open source software programs, refer to
the detailed terms and conditions thereof shown in the installation package of the Software.
Should a discrepancy arise between any of the terms of this Agreement and any open source
software program license statement, the open source software program license statement shall
take precedence over this Agreement.
Article 1 Grant of License
PIDSX hereby grants to you a non-exclusive license to use this Software only in combination
with PIDSX product(s) specified in the manual of this Software (the “Product”) in accordance
with the terms of this Agreement. You may not use this Software in connection with products of
any third party other than PIDSX.
Article 2 Restrictions
You may NOT:
(1)Modify, reverse engineer, decompile, or disassemble this Software,
(2)Use this Software by methods or for purposes other than those specified in the manual of
this Software provided by PIDSX, nor
(3)Distribute, rent, lease or otherwise transfer this Software to any third party; provided,
however, that you may assign the rights to use this Software under this Agreement along with
the Product on the condition that the assignee agrees to be bound by all the terms of this
Agreement. In the case of such assignment, you must deliver any and all the copies of this
Software and all the accompanying materials to the assignee and you may not retain any
copies of this Software including backups.
Article 3 Disclaimer
3-1. PIDSX MAKES NO WARRANTY OR REPRESENTATION OF ANY KIND, EXPRESS,
IMPLIED OR STATUTORY, WITH RESPECT TO THIS SOFTWARE, INCLUDING BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR
PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS.
3-2. UNDER NO CIRCUMSTANCES SHALL PIDSX BE LIABLE FOR ANY DAMAGES
(INCLUDING DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES
WHATSOEVER) ARISING OUT OF THE USE OF THIS SOFTWARE, INABILITY TO USE
THIS SOFTWARE, DEFECTS IN THIS SOFTWARE (e.g., BUGS, SECURITY HOLES, AND
MALFUNCTION), OR OTHERWISE IN CONNECTION WITH THIS SOFTWARE.
Article 4 Term
4-1. This Agreement shall come into effect upon your unsealing the package of this Software, or
your downloading, installing or launching this Software or the like.
4-2. PIDSX may terminate this Agreement immediately, if you breach any of the provisions of
this Agreement.
4-3. You shall, at your own costs, return, delete or destroy this Software and any of its copies
within four (4) weeks after termination of this Agreement.
Article 5 Export Control

1.2 Software License Agreement
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You shall comply with all laws and regulations regarding export control under any competent
jurisdiction, including but not limited to the Japanese Foreign Exchange & Foreign Trade
Control Law, the export control regulations based on resolutions of the United Nations Security
Council, etc. If any license or appropriate approval from a governmental authority is required
under the applicable laws, you may not export this Software without such approval to any
countries either directly or indirectly. Furthermore, you shall neither use nor sell this Software
for military purposes either directly or indirectly.
Article 6 Intellectual Property Rights
Except the open source software program, all intellectual property rights in this Software,
including the copyright, belong to PIDSX and/or the licensors of PIDSX.
Article 7 Upgrade of this Software
7-1 Release of future upgrades or updates of this Software is not guaranteed and left to the
sole discretion of PIDSX. Furthermore, PIDSX may charge fees for upgrading or updating of
this Software.
7-2. If any upgrades or updates are provided to you either for fees or for free, such upgrades or
updates shall be deemed as a part of this Software and shall be governed by this Agreement,
unless PIDSX designates otherwise at the time of provision of such upgrades or updates.
Article 8 Limitation on Liability
AGGREGATE LIABILITIES OF PIDSX IN CONNECTION WITH THIS AGREEMENT OR THIS
SOFTWARE SHALL IN NO EVENT EXCEED TEN THOUSAND (10,000) YEN.
Article 9 Governing Law and Jurisdiction
9-1. This Agreement shall be governed by the laws of Japan.
9-2. Should any dispute arise from or in connection with this Agreement, Nagoya District Court,
Japan shall exclusively have jurisdiction over such dispute.
This Software consists of the following types of software.
(1) Software developed independently by PIDSX
(2) Software owned by a third party and licensed to PIDSX
(3) Open source software licensed on conditions of such open source software PIDSX makes
no warranty, including implied warranties of merchantability and/or fitness for particular purpose
to software in category (3) above. For details, Please refer to the detailed terms and conditions
thereof shown in the installation package of this Software.

1.2 Software License Agreement
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2 System Configuration

2.1  System Configuration Diagram...........................................................2-2
2.2  Configuration Tool Software "HL-G2 Configuration Tool" ................2-4

2.2.1  System requirements ....................................................................... 2-4
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2.1 System Configuration Diagram

The figure below shows a system configuration and cables connecting each device.

Ethernet communication

RS-485 communication

2.1 System Configuration Diagram
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RS-485 wiring allows connection of up to 16 devices.

● This product contains built-in termination resistance. Be sure to turn ON the termination
resistance on the terminal unit sensor.

● For stability of RS-485 communication, check the system operation by connecting actual
devices on your own. The number of units connected, transmission distance, and transmission
speed may vary depending on the connected device and transmission path.

● The maximum cable length of the optional cable (RS-485 type) is 20 m. It is recommended that
the total cable length from the RS-485 connected device to this product be 20 m or less.

● For RS-485 wiring, use multi-point connection.

2.1 System Configuration Diagram
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2.2 Configuration Tool Software "HL-G2 Configuration Tool"

"HL-G2 Configuration Tool" is configuration tool software dedicated to the HL-G2 series.
Installing this tool software on a PC enables the user to set up the connected HL-G2 sensors,
record measured values, and perform other operations.

2.2.1 System requirements

The table below shows the system requirements to use HL-G2 Configuration Tool. Check
whether the system to be used meets the requirements and the necessary devices are
prepared.

Item Specifications

OS
Windows(R) 10 (32 bit / 64 bit)

Windows(R) 11 (64 bit)

CPU Intel(R) Core™ i3 1 GHz or faster

Memory 2 GB or more

Available hard disk space 200 MB or more

Screen resolution 1366 × 768 or higher (recommended)

Display language Japanese, English, Chinese (Simplified), and Korean

Communication interface Ethernet, RS-485

Operating conditions .NET Frameworks 4.8 or later must be installed.

2.2 Configuration Tool Software "HL-G2 Configuration Tool"
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3.1 Flow of Operations up to Setup Completion

This section explains the flow ofHL-G2 Configuration Tooloperations up to the completion of
main unit setup.
1. Preparation

Download HL-G2 Configuration Tool from PIDSX website (https://panasonic.co.jp/id/pidsx/)
and install it on a PC.
"3.3.1 Installing HL-G2 Configuration Tool"

2. Starting the tool

Connect the sensor and the PC, and startHL-G2 Configuration Tool.
"3.2 Optional Cable Connection Method"
"3.4.1 Starting HL-G2 Configuration Tool"

3. Loading the settings

Load the sensor settings intoHL-G2 Configuration Tool.
"3.4.1 Starting HL-G2 Configuration Tool"

4. Checking the received light intensity waveform

Check the received light intensity waveform.
"4.5 "Monitor" tab"
"4.7 "Settings" tab"

5. Configuring sensor settings

Configure various sensor settings using HL-G2 Configuration Tool.
"4.7 "Settings" tab"
"4.7.1 List of configuration parameters"

6. Writing the settings

Write the settings to the sensor.
"5.1.2 Writing the settings"

7. Saving the configuration file

Save the settings on the PC.
"Save as"

3.1 Flow of Operations up to Setup Completion
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3.2 Optional Cable Connection Method

● When using the optional cable, confirm that there is no foreign matters in the connector
part before using the cable.

● Always grasp the connector body when connecting or disconnecting the connector. Wires
may break if excessive stress is applied to the cable.

● Insert the connector all the way in and tighten the M2.6 screws to this product before
using it. If the connectors are not completely connected, the sensor unit may become
damaged.

● Do not insert the connector at an angle. Otherwise, connector pins may be bent.

1. Insert the sensor unit connection connector on the optional cable into the sensor unit cable
connector.
When doing this, insert the protrusions on the sensor unit connector on the communication
cable into the holes on the connector for the sensor unit connection cable.

2. Tighten the two M2.6 screw. Tighten the two M2.6 screw. (Tightening toque 0.23 to 0.3
N·m)

3. When removing the connecting cable from the sensor, loosen the two M2.6 screws, hold
the connector part of the cable, and pull out the cable.

3.2 Optional Cable Connection Method
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3.2 Optional Cable Connection Method
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3.3 Installation and Uninstallation Procedures

3.3.1 Installing HL-G2 Configuration Tool

This section explains the procedure for installingHL-G2 Configuration Toolon a PC.

● The"User Account Control"confirmation window may be displayed. In such a case, click[Yes]to
proceed with the change procedure.

1. Double-click the"setup.exe"file that you downloaded.

2. Select the target language and click[OK].

3. Click[Next].

4. The "License Agreement" window will be displayed. Carefully read the agreement, select "I
accept the terms of the license agreement", and click [Next].

3.3 Installation and Uninstallation Procedures
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5. If you do not change the installation folder, click[Next]. If you change the installation folder,
select a desired folder and then click[Next].

6. Click[Install].

3.3 Installation and Uninstallation Procedures
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7. Click[Finish].

8. TheHL-G2 Configuration Toolicon will be displayed on the desktop.

3.3.2 Uninstalling HL-G2 Configuration Tool

To uninstall HL-G2 Configuration Tool, on the Windows desktop, right-click
Start>Settings>Apps>Apps & features and then select Panasonic-ID SUNX Sensor HL-G2
Configuration Tool and execute uninstallation.

3.3 Installation and Uninstallation Procedures
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3.4 Starting and Exiting Procedures

3.4.1 Starting HL-G2 Configuration Tool

This section explains the procedure for starting HL-G2 Configuration Tool.

1. Double-click the HL-G2 Configuration Tool icon on the Windows desktop, or from the
Windows start menu, select Panasonic-ID SUNX Sensor>HL-G2 Configuration Tool.

2. When HL-G2 Configuration Tool is started, the "Start menu" window is displayed.

No. Item Description

1 Create a new file
This item allows the user to create a new configuration file.
For details, refer to "7.3.1 Creating a new configuration file".

2 Open a file
This item allows the user to open an existing configuration file.
For details, refer to "7.3.2 Opening a configuration file".

3 Read from sensors

This item allows the user to read settings from sensors.
For the procedure for reading settings from connected sensors,
refer to "Reading settings from connected sensors".
For the procedure for searching for serial communication sensors,
refer to "Searching for serial communication sensors".

4 "Connecting sensors"display
area

This area displays the sensors that are currently connected. If "Read
from sensors" is selected, this area will be enabled.

3. Select a desired startup method and click [Start].

3.4 Starting and Exiting Procedures
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Reading settings from connected sensors

If"Read from sensors"is selected in the "Start menu" dialog box, select the sensors connected
to the PC to create a device list. For details on device lists, refer to"4.4 Device list".

Select the check boxes of the sensors from which settings are to be read and then click[Start].

3.4 Starting and Exiting Procedures
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● If the"Select all"check box is selected, the check boxes of all sensors will be selected. Similarly,
if the"Select all"check box is canceled, the check boxes of all sensors will be canceled.

● If there is a problem with IP address settings, a warning icon will be displayed.

In such a case, check for the following problems.
1. The subnet of the sensors differs from that of the PC.
2. There are duplicate sensor IP addresses.
Clicking the warning icon or IP address text displays an IP settings change dialog box, so that
you can change the IP address settings.

If you have changed the IP settings, click [Write] to write the settings to the sensor, Note that
setting duplicate IP addresses for the PC and sensors may prevent the automatic configuration
from configuring the IP settings as intended. If changing the IP settings fails, refer to
"6.1.1 Configuring sensor IP settings".

Searching for serial communication sensors

This section explains the procedure for searching for sensors connected via serial
communication.

1. Click the target port number on the right side of the "Connecting sensors" area.

3.4 Starting and Exiting Procedures
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2. Configure settings in the "Device Address", "Comm Speed", "Data length", "Parity", and
"Stop Bit" fields and then click [Search].

● For each parameter, set the same values as the settings of the connected sensor. Holding
down the [Enter] button on the sensor for two seconds invokes the "Setting mode" in which
you can check the communication settings.

3. A confirmation dialog box will be displayed, asking whether to conduct sensor searches.
Clicking [Yes] starts searching.

4. Found sensors will be added to the "Connecting sensors" area.

3.4 Starting and Exiting Procedures
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3.4.2 Exiting HL-G2 Configuration Tool

Use one of the following methods to exit HL-G2 Configuration Tool.

● A confirmation message will be displayed, asking whether to save the configuration file. If
you must save the configuration file, click[Yes]. If you click[No], the changed settings will
be discarded.

● On the menu bar, selectFile>Exit.
● Click the[close]button in the top right corner of the tool software window.

3.4 Starting and Exiting Procedures
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4.1 Main Window

Name Description Reference section

1 Menu bar Displays the menus of each function used byHL-G2
Configuration Tool "4.2 Menu Bar"

2 Quick Access
Toolbar

Arranges icons that allow the user to quickly execute
frequently used functions such as "New", "Save", and
"Copy"

"4.3 Quick Access
Toolbar"

3 Title bar Displays the configuration file name and tool software
name ―

4 Device list Displays the sensors that are currently edited or
connected "4.4 Device list"

5 "Monitor"tab
Allows the user to check the received light intensity
waveforms, I/O, and measured values of the selected
sensor

"4.5 "Monitor" tab"

6 "High-speed
logging"tab

Allows the user to record measured values in every
sampling cycle for the purpose of sensor performance
evaluation or maintenance

"4.6 "High-speed
logging"Tab"

7 "Settings"tab Allows the user to set up the selected sensor "4.7 "Settings" tab"

8 "Device
information"tab

Allows the user to check device information for the
selected sensor

"4.8 "Device
information"tab"

4.1 Main Window
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4.2 Menu Bar

This section explains the functions that can be executed from the menu bar.

4.2.1 File

This menu allows the user to set operations related to configuration files, as well as options and
language.

New

This item allows the user to create a new configuration file. (Shortcut keys: <Ctrl>+<N> keys)
For details, refer to "7.3.1 Creating a new configuration file".

Open

This item allows the user to open an existing configuration file. (Shortcut keys: <Ctrl>+<O>
keys)
For details, refer to "7.3.2 Opening a configuration file".

Save

This item allows the user to overwrite an existing configuration file. (Shortcut keys: <Ctrl>+<S>
keys)

Save as

This item allows the user to rename and save the specified file.

● The save format is "HL-G2 settings" format and the extension is ".hlg".

4.2 Menu Bar
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Read from sensors

Select the sensors connected to the PC to create a device list. For details on device lists, refer
to "4.4 Device list".

● If the device list has been changed, a confirmation message will be displayed, asking
whether to save the configuration file. If you must save the configuration file, click [Yes]. If
you click [No], the changed settings will be discarded.

To read settings from connected sensors, select the check boxes of the sensors from which
settings are to be read and then click [Add]. For details, refer to "Reading settings from
connected sensors". For the procedure for searching for serial communication sensors, refer to
"Searching for serial communication sensors".

Option

Specifying a password prevents the settings of sensors from being changed. For details, refer
to "7.6.1 Setting a password".

● If you have forgotten the specified password, you can initialize the password.
For details on the initialization procedure, refer to "7.6.3 Initializing a password".

Language

This item allows the user to select a desired display language for HL-G2 Configuration Tool.

4.2 Menu Bar
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If you have changed the display language, you must restart HL-G2 Configuration Tool. A
confirmation message will be displayed. If you click [Yes], HL-G2 Configuration Tool will be
restarted and the change will be applied.

Exit

This item allows the user to exit HL-G2 Configuration Tool. (Shortcut keys: <Alt>+<F4> keys)

4.2.2 Edit

This menu allows the user to copy the settings of one sensor and paste them to another sensor.

Copy

This item allows the user to copy all settings of the specified sensor. (Shortcut keys: <Ctrl>
+<C> keys)
For details, refer to "7.4 Copying Settings".

Paste

This item allows the user to paste the copied settings to a different sensor. (Shortcut keys:
<Ctrl>+<V> keys)
For details, refer to "7.4.1 Pasting settings".

Select and Paste

This item allows the user to paste only the selected parts of copied settings to a different
sensor. (Shortcut keys: <Ctrl>+<Alt>+<V> keys)
For details, refer to "7.4.2 Selecting and pasting settings".

4.2 Menu Bar
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Settings collation

This item allows the user to compare sensor settings and check the differences. For details,
refer to "7.5 Comparing Settings".

4.2.3 Tool

This menu allows the user to diagnose sensor states.

Diagnostic information

The diagnostic information window is shown below.

Name Function

1 State

The following sensor states are displayed.
"Fault": Indicates the state in which sensor replacement or wiring check is required due
to component damage or wiring breakage or for some other reason.
"Caution": Indicates the state in which sensor replacement is recommended because
the saving count has exceeded the upper limit, for example.
"Notification": Indicates the state in which issues that occur during normal use, such as
setting errors or a drop in received light intensity, are detected.

2 Serial No. Indicates the serial number of the connected sensor.

3 Label Indicates the label set for the connected sensor. For details, refer to "7.2 Setting Labels
to Sensors".

4 Diagnostic
result Indicates the problem detected by diagnosis.

5 Action Indicates the action that should be taken to resolve the problem.

4.2 Menu Bar
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4.2.4 Help

This menu allows the user to refer to the manual and check the software version of HL-G2
Configuration Tool.

Manual

This item allows the user to refer to the manual of HL-G2 Configuration Tool.

Version information

This item allows the user to check version information for HL-G2 Configuration Tool.

4.2 Menu Bar
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4.3 Quick Access Toolbar

Some functions can be executed from their respective icons on the Quick Access Toolbar.

Icon Name Reference section

New "New", "7.3.1 Creating a new configuration file"

Open "Open", "7.3.2 Opening a configuration file"

Save "Save"

Save as "Save as"

Read from sensors "Read from sensors"

Copy "Copy", "7.4 Copying Settings"

Paste "Paste", "7.4.1 Pasting settings"

Select and Paste "Select and Paste", "7.4.2 Selecting and pasting settings"

Settings collation "7.5 Comparing Settings"

Diagnostic information "Diagnostic information"

Manual "Manual"

Version information "Version information"

4.3 Quick Access Toolbar
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4.4 Device list

This window displays a list of sensors that are currently connected or edited. If you select a
sensor in the "Device list" window, the "Monitor" tab, "High-speed logging" tab, "Settings" tab,
and "Device information" tab for the selected sensor will be enabled. The "Device list" window
consists of the components shown below.

Name Description

1 Connection state icon
This icon indicates the connection state of the sensor and PC.
For details, refer to "4.4.1 Connection state".

2 Product image This icon is a visual representation of the product. Clicking the icon
displays the occurrence situation of errors and alarms.

3 Connection state
This section indicates the connection state of the sensor and PC.
For details, refer to "4.4.1 Connection state".

4 Communication interface This section indicates the communication interface of the connected
sensor.

5 Product type This section indicates the product type of the connected sensor.

6 Label
This section indicates the label set for the sensor.
For details, refer to "7.2 Setting Labels to Sensors".

7 Model This section indicates the model of the sensor.

8 Measured value This section indicates the measured value from the sensor.

9 Output state
This section indicates the output state of the sensor.
For details, refer to "4.4.3 Output state".

10 Selected bank
This section indicates the selected bank.
For details, refer to "5.6.1 Bank operation".

4.4 Device list
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Name Description

11 Error and alarm icons

These icons indicate the occurrence situation of sensor errors and
alarms, as well as the number of occurrences.
For details on the icons, refer to "4.4.2 Error and alarm icons". For details
on how to resolve sensor errors and alarms, refer to "8 Troubleshooting".

12 Multimonitor
This function monitors multiple sensors.
For details, refer to "7.1 Monitoring Multiple Sensors".

13 [Add] button
Clicking this button adds new or connected sensors to the "Device list"
window.
For details, refer to "4.4.4 Adding sensors".

14 [Delete] button
Clicking this button removes sensors from the "Device list" window.
For details, refer to "4.4.5 Removing sensors".

4.4.1 Connection state

The connection state of the sensor and PC is displayed as below.

Connection state Icon display Status
display Description

Offline setting None

The sensor has not been connected at all.
● The status is displayed as[Connection].
● The "Monitor" tab is not displayed.
● No graph is displayed in the "Settings" tab and"Not

connected."is displayed.

Connected The sensor is connected online.

Disconnection

The sensor was connected online once, but it was
disconnected.
● No graph is displayed in the "Settings" tab

and"Waveform cannot be collected."is displayed.
● Errors and alarms cannot be collected from the

sensor unit.

4.4.2 Error and alarm icons

If an error occurs on the sensor or the specified alarm conditions are satisfied, the icons shown
below and the number of occurrences will be displayed on the product image. Clicking on the
product image displays details of the error or alarm.

Display Description

An error occurred on the sensor.
For details on how to resolve the error, refer to "8.1 Error Messages and Action Methods".

The specified alarm conditions are satisfied.
For details on how to resolve the alarm, refer to "8.2 Alarm Messages and Action Methods".

4.4 Device list
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4.4.3 Output state

The output states of connected sensors are displayed as below.

Output state Display Conditions

GO The measured value displayed is within the threshold range.

LOW The measured value displayed dropped below the LOW set value.(Note 1)

HIGH The displayed measured value exceeded the upper threshold.(Note 2)

Data
indeterminate Measurement is not made correctly. This is not an error.

Out of display
range (+)

The measured value exceeded the display range on the positive side.
(Note 3)

Out of display
range (-)

The measured value exceeded the display range on the negative side.
(Note 4)

Error
An error occurred on the sensor.
For details on how to resolve the error, refer to"8.1 Error Messages and
Action Methods".

Alarm
The specified alarm conditions are satisfied.
For details on how to resolve the alarm, refer to"8.2 Alarm Messages
and Action Methods".

 

(Note 1) When the measured value displayed and the LOW set value are the same, the output state may
be"LOW".

(Note 2) When the measured value displayed and the HIGH set value are the same, the output state may
be"HIGH".

(Note 3) When data is output, the measured value is fixed at +960.
(Note 4) When data is output, the measured value is fixed at -960.
 

4.4.4 Adding sensors

This section explains how to add sensors to the "Device list" window.

1. Click the [Add] button on the bottom of the "Device list" window.

4.4 Device list
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2. The "Add sensors" menu window will be displayed. Select sensors to be added. If the "New
Sensors" tab is selected, you can select any new sensors. If the "Connected Sensors" tab
is selected, you can select sensors to be added from all the connected sensors.

3. Clicking the [Add] button adds the selected new sensors to the "Device list" window.

4.4 Device list
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4.4.5 Removing sensors

This section explains how to remove sensors from the "Device list" window.

1. Select sensors to be removed from the "Device list" window and click the [Delete] button.

2. A confirmation message will be displayed. Clicking [Yes] removes the selected sensors
from the "Device list" window.

4.4 Device list
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4.5 "Monitor" tab

This tab allows the user to monitor the waveform of received light intensity, measured values,
and I/O of sensors.

Name Description

1 Monitor selector This section allows the user to switch the display between
"Waveform of received light intensity" and "Measured value".

2 Waveform of received light intensity
monitor / Measured value monitor

Each tab displays waveform of received light intensity or
measured values.
For details, refer to "4.5.1 Received light intensity waveform
monitor" or "4.5.2 Measured value monitor".

3 Image output / Data output
Clicking each button outputs waveform of received light intensity
or measured values to a file.
For details, refer to "4.5.3 Export as Image / Data output".

4 I/O monitor(Note 1) This section indicates the I/O state.
For details, refer to "4.5.4 I/O monitor".

 

(Note 1) "I/O monitor" is not displayed when the Multimonitor function is used.
 

4.5.1 Received light intensity waveform monitor

This area displays the received light intensity waveforms of sensors.

4.5 "Monitor" tab
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Name Description

1 Vertical axis This axis represents the intensity of received light.

2 Horizontal axis This axis represents each cell position in the light receiving section of the sensor.

3 Received light
intensity waveform

This graph is drawn by plotting received light intensities and cell positions.
● Normally, received light intensity waveforms are displayed in green.
● In the event of an alarm, received light intensity waveforms are displayed in

yellow.(Note 1)

● If received light intensity waveforms cannot be collected due to laser emission
OFF or for some other reason, the entire display area will be grayed out.

● The display area can be zoomed in or zoomed out by rotating the mouse wheel
while the mouse pointer is within the display area. The display area can also be
zoomed in or zoomed out at low speed by rotating the mouse wheel while
holding down the <Ctrl> key.

4 Peak value This section indicates the maximum value of received light intensity waveforms.

5 Peak cell This section indicates the cell position of the peak value.

6 Laser Stop(Note 2)
This switch allows the user to stop or start laser emission.
● Setting [Laser Stop] to ON stops laser emission.
● Setting [Laser Stop] to OFF starts laser emission.

 

(Note 1) If an alarm is delayed or hold is set in the event of an alarm, the color of the graph may remain green
even when received light intensity waveforms are in the alarm state.

(Note 2) "Laser Stop" is not displayed when the Multimonitor function is used.
 

4.5 "Monitor" tab
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4.5.2 Measured value monitor

This tab allows the user to display measured values or perform logging to continue collecting
measured values in any desired data cycle.

Name Description

1 Vertical axis This axis represents measured values.

2 Horizontal axis This axis represents the elapsed time from the start of logging. The axis scrolls
horizontally in accordance with the elapsed time.

3 Measured value
graph

This graph is drawn by plotting measured values and elapsed time. The display
area can be zoomed in or zoomed out by rotating the mouse wheel while the
mouse pointer is within the display area. The display area can also be zoomed in or
zoomed out at low speed by rotating the mouse wheel while holding down
the<Ctrl>key.

4 Slider This slider allows the user to change the display range of measured value graphs.

5
[Start]button
[Pause]button
[Resume]button

This button allows the user to perform logging to continue collecting measured
values in any desired time cycle.
● Clicking the "Start" button before the start of logging starts logging. The button

display will be changed as follows:Start>Pause.
● Clicking the "Pause" button during logging pauses logging. The button display

will be changed as follows:Pause>Resume.(Note 2)

● Clicking the "Resume" button during paused logging resumes logging. The
button display will be changed as follows:Resume>Pause.

6 [Clear]button
This button allows the user to erase logged results. If you click the[Clear]button and
then[Yes]in the confirmation message window, you can erase the logged results
and start new logging.

7 Data cycle This section indicates the time cycle in which measured values are to be collected
by logging.

4.5 "Monitor" tab
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Name Description
The minimum settable value is 10 ms and the maximum settable value is 400 ms.
(Note 3)

8 [Hold]button This button allows the user to switch the hold state between ON and OFF.(Note 4)

(Note 5)

9 [Reset]button This button sends "Measured Value Resetting" to the sensor.(Note 4)(Note 5)

 

(Note 1) The maximum allowable number of measurement times per logging is 60,000.
(Note 2) Logged data is not saved at the time of pause. For details on how to save logged data, refer

to"4.5.3 Export as Image / Data output".
(Note 3) By default, the data cycle is set to 200 ms.
(Note 4) The[Hold]and[Reset]buttons are used to perform trigger input. For details on trigger input, refer to

theHL-G2 Series User’s Manual (Communication Type).
(Note 5) The[Hold]and[Reset]buttons are not displayed when the Multimonitor function is used.
 

If an abnormality occurs during logging, the following will be displayed.

Name Description

1
Data loss
Indeterminate data

When data is lost or becomes indeterminate, the zone where such a
problem has occurred is displayed as a gray background.

2
Error / alarm occurrence
Out of display range

When an error or alarm occurs or data goes beyond or falls below the
display range, the zone where such a problem has occurred is displayed as
a red background.

4.5.3 Export as Image / Data output

The "Export as Image" or "Data output" button allows the user to perform image output or data
output for graph information displayed in the Monitor window.

4.5 "Monitor" tab
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Export as Image

This section explains how to output graphs displayed in the Monitor window as image data in
PNG format.

1. Click the [Export as Image] button.

2. The "Save as" dialog box will be displayed. Specify a storage location and file name and
then click [Save].

3. Graphs will be output in PNG format to the specified storage location.

Data output

This section explains how to output graphs displayed in the Monitor window as data in XLSX or
CSV format.

1. Click the [Data output] button.

2. The "Save as" dialog box will be displayed. Specify a storage location, file name, and data
format and then click [Save].

3. A file with the specified format will be output to the specified storage location.

4.5 "Monitor" tab
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The "Data output" button in the Monitor window outputs the following kinds of data.

Received light intensity waveform monitor Measured value monitor

● Received light intensity peak state (Normal or
abnormal)

● Peak value
● Peak cell
● Cell number (Horizontal axis of graph)
● Received light intensity (Vertical axis of graph)
● Creation of graphs on "Graph of received light

intensity" sheet (For XLSX format)

● Measurement start date
● Data cycle
● Time of acquisition (Horizontal axis of graph)
● Measured value (Vertical axis of graph)
● Error information
● Creation of graphs on "Measured value logging

graph" sheet (For XLSX format)

4.5.4 I/O monitor

This section displays the I/O ON/OFF states of connected sensors, allocated functions, and
other information.

Name Description

1 State

The ON/OFF state of I/O is displayed.

ON:  is displayed.
OFF: None

2 Item The allocated function is displayed.

3 Remarks Supplemental information on I/O monitor is displayed.(Note 1)

 

(Note 1) External I/O information is displayed as"cable color"and"cable No."
 

4.5 "Monitor" tab
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4.6 "High-speed logging"Tab

This tab allows the user to record measured values in every sampling cycle for the purpose of
sensor performance evaluation or maintenance.

Name Description

1 Vertical axis This axis represents measured values.

2 Horizontal axis This axis represents elapsed time.

3 Measured value
graph This graph is drawn by plotting measured values and elapsed time.

4 Range specification This section allows the user to specify the display range for logging results.
Values can be entered only after logging.

5 [Start]button
This button allows the user to start high-speed logging.
For details on the operating method, refer to"4.6.1 High-speed logging".

6 No. of samples(Note

1)
This section allows the user to specify the number of times sampling is performed
for high-speed logging. Sampling is performed the specified number of times.

7 Thinning
This section allows the user to specify an interval used to thin out sampling. If, for
example,"1/4"is specified, sampling is performed to obtain a measured value from
one of four sampling operations. In this case, measurement time is four times
longer than the normal measurement time.

8 Logging time(Note 2) This value indicates approximate time required for logging. It is calculated from
the values in "Sampling cycle," "No. of samples," and "Thinning."

9 Parameters This area displays configuration parameters related to the conditions for high-
speed logging.

4.6 "High-speed logging"Tab
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Name Description
For details on each parameter, refer to"4.7.1 List of configuration parameters".

10 Logging results

This area displays the logging conditions, entire logging results, and the logging
results of the area specified by "Range specification."
● Maximum value: Maximum value within the entire area or the area specified

by "Range specification"
● Minimum value: Minimum value within the entire area or the area specified by

"Range specification"
● Peak-to-peak: Difference between the maximum value and minimum value

 

(Note 1) The maximum number of samples is 30,000.
(Note 2) Displays only the time taken for measurement. Depending on the communication environment, it may

take time to display results after completion of measurement.
 

4.6.1 High-speed logging

This section explains how to perform high-speed logging.

1. In the "Settings" tab, set the following parameters.
● Sampling Frequency
● Average Times
● Hold Mode
● Reverse of Measured Value
For details on how to set these parameters, refer to "4.7 "Settings" tab". For details on each
parameter, refer to "4.7.1 List of configuration parameters".

2. In the "High-speed logging" tab, set the following parameters.
● No. of samples
● Thinning

For details on each parameter, refer to "4.6 "High-speed logging"Tab".

3. Click the [Start] button to start logging.

4.6 "High-speed logging"Tab
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4. Check the logging results. Entering values in the "Range specification" section allows the
user to adjust the display area for graphs.

● If the following operations are performed, logged data will be cleared.
• Changing the tab
• Changing the selected sensor in the "Device list" window
• Exiting HL-G2 Configuration Tool
• Adding or removing sensors to/from the "Device list" window
• Connecting sensors
• Executing "Read from sensors"
• Executing "New" or "Open" from the "File" menu

4.6 "High-speed logging"Tab
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4.6.2 Data output

This section explains how to output graphs displayed in the "High-speed logging" tab as data in
XLSM or CSV format.

1. Click the[Data output]button.

2. The"Save as"dialog box will be displayed. Specify a storage location, file name, and data
format and then click[Save].

● The "Data output" button in the "High-speed logging" tab outputs the following kinds of
data.
• Date of measurement start
• Model name
• Interface
• Serial No.
• System version (version information of the sensor unit)
• Distance type
• Sampling cycle [ms]
• Average count
• Hold mode
• Inversion of Measured Value
• Data cycle [ms]
• No. of samples
• Thinning
• Maximum elapsed time [s]
• Minimum elapsed time [s]
• Maximum measured value [mm]
• Minimum measured value [mm]
• Peak-to-peak [mm]
• Creation of graphs on "High-speed logging graph" sheet (For XLSM format)

High-speed logging graph

If you have output logging results as data in XLSM format, create graphs on the "High-speed
logging graph" sheet. Create two types of graph: "Measured value graph (whole)" and

4.6 "High-speed logging"Tab
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"Measured value graph (specified range)". In "Measured value graph (specified range"), you
can adjust the display range.

To adjust the display range, enter the maximum elapsed time and minimum elapsed time of the
display range in the yellow cells and then click the[Graph update]button.

4.6 "High-speed logging"Tab
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4.7 "Settings" tab

This tab allows the user to set up each parameter for the selected sensor.

Name Function Reference section

1 Received light intensity
waveform monitor

This area displays received light intensity
waveforms.

"4.5.1 Received light intensity
waveform monitor"

2 Configuration parameter
area

This area allows the user to check and edit
each parameter for the selected sensor.
When HL-G2 Configuration Tool is
started, this area is displayed in "simple
settings mode" in which only the general
parameters are displayed.

"4.7.1 List of configuration
parameters"

3 "Advanced settings mode"
check box

Selecting this check box displays all
parameters in the configuration parameter
area so that more detailed settings can be
specified.

"4.7.1 List of configuration
parameters"

4 [Write] button
Clicking this button writes the parameter
settings in the configuration parameter area
to the sensor.

"5.1.2 Writing the settings"

5 [Read] button
Clicking this button reads the parameter
settings from the sensor and reflects them
into the configuration parameter area.

"5.1.1 Reading the settings"

6 "Write automatically"
check box

Selecting this check box automatically
reads the parameter settings from the
sensor and reflects them into the
configuration parameter area. Similarly,

4.7 "Settings" tab
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Name Function Reference section
when each parameter is changed, the
parameter settings will be automatically
written to the sensor even if the [Read]
button is not clicked.

4.7.1 List of configuration parameters

The following list shows the parameters and items that can be set withHL-G2 Configuration
Tool.
For details on each parameter, refer to the sections in the "Reference section" column and
theHL-G2 Series User’s Manual (Communication Type).

Configuration parameter
Advanced
settings

mode(Note 1)
Reference section

Sensitivity setting Brightness Tuning "5.2 Adjusting Sensitivity"

Measurement
settings

Inversion of Measured Value
"5.3 Configuring Measurement
Settings"Sampling period

Average Times

Correction settings

Span

"5.4 Configuring Correction Settings"

Offset

Zero Setting

Hold Mode ●

Trigger Mode ●

Operation setting

Threshold

HIGH Set Value

"5.5 Configuring Operation Settings"
"5.5.1 Teaching"

LOW Set Value

Teaching

Hysteresis ●

Output Delay Timer

Timer selection ● "5.5 Configuring Operation Settings"
"5.5.2 Configuring digital output
settings"Timer setting ●

Alarm

Delay count at alarm
occurrence ●

"5.5 Configuring Operation Settings"
"5.5.3 Configuring alarm settings"Digital output at alarm

occurrence ●

Configuration

Bank settings

Item to be read and written "5.6 Performing Configuration"
"5.6.1 Bank operation"Bank operation

Number of digits displayed ●
"5.6 Performing Configuration"

Eco mode ●

4.7 "Settings" tab
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Configuration parameter
Advanced
settings

mode(Note 1)
Reference section

Reverse video ●

Key lock ●

Display language ●
 

(Note 1) The items marked with ● in the "Advanced settings mode" column are displayed only when
the"Advanced settings mode"check box is selected.

 

4.7 "Settings" tab
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4.8 "Device information"tab

This tab allows the user to check device information and set a label, perform initialization,
configure IP settings, and perform other operations for the selected sensor.

Ethernet communication type

4.8 "Device information"tab
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Serial communication type

Name Function Reference section

1 Label This field allows the user to check and
set a label.

"7.2 Setting Labels to
Sensors"

2 Sensor information This section displays information for the
selected sensor.

3 [Initialize Sensor]button(Note 1) This button allows the user to initialize
sensor settings. "7.7.1 Initialize Sensor"

4 [Initialize Bank]button(Note 1) Clicking this button initializes the
specified bank. "7.7.2 Initialize Bank"

5 [SLMP settings]button(Note 2) Clicking this button allows the user to
check and set up SLMP communication.

"6.2 Configuring SLMP
Settings"

6 IP settings(Note 2) This section allows the user to check and
set up Ethernet IP. "6.1 Configuring IP Settings"

7 Maintenance information(Note

3)
This section displays the cumulative
operating period of the sensor (in hours).

 

(Note 1) Executing[Initialize Sensor]or[Initialize Bank]deletes the set values. Before execution, we recommend
that you save the configuration file. For details on saving a configuration file refer to"4.2.1 File".

(Note 2) The[SLMP settings]button and"IP settings"are displayed only for the Ethernet communication type.
(Note 3) The value of "Cumulative operation hours" is updated when the "Device information" tab is displayed.

When the cumulative operating period exceeds 87,600 hours, the diagnostic information function
displays "Caution".

 

4.8 "Device information"tab
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(MEMO)
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5.1 Reading and Writing the Settings

Settings can be written to sensors from HL-G2 Configuration Tool and can also be read from
sensors into HL-G2 Configuration Tool.

● Before writing or reading settings, make sure that the PC and sensor can communicate
with each other correctly.

5.1.1 Reading the settings

This section explains how to read settings from sensors into HL-G2 Configuration Tool.

1. In the "Device list" window, select a desired sensor from which settings are to be read.

2. Click the [Read] button.

3. A confirmation message will be displayed. If you click [Yes], settings will be read from the
sensor into HL-G2 Configuration Tool.

5.1.2 Writing the settings

This section explains how to write settings to sensors from HL-G2 Configuration Tool.

5.1 Reading and Writing the Settings
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1. In the "Device list" window, select a desired sensor to which settings are to be written.

2. Click the [Write] button.

3. A confirmation message will be displayed. If you click [Yes], settings will be written to the
sensor from HL-G2 Configuration Tool.

● If configuration parameter settings are changed, the [Write] button will blink. In this
situation, if you change the selected sensor or perform another operation to switch the
window, a confirmation message will be displayed, asking whether to write settings. If you
click [Yes], settings will be written to the sensor from HL-G2 Configuration Tool. If you
click [No], the window will be switched. When the same window is displayed again, a
confirmation message will be displayed, asking whether to write settings.

● If the "Write automatically" check box is selected, when a configuration parameter is
changed, the changed parameter settings will be simultaneously written to the selected
sensor.

● For details on how to write settings that are configured offline when the PC does not
communicate with any sensor, refer to "7.3.3 Writing settings configured offline".

5.1 Reading and Writing the Settings
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5.2 Adjusting Sensitivity

Brightness tuning settings for laser beams can be changed according to the measured objects.
When two workpieces that significantly differ in brightness are measured, brightness tuning may
stabilize accuracy. Implementing brightness tuning requires two workpieces that differ in
brightness.

Name Description

1 Brightness Tuning

When turning OFF: The laser beam brightness is automatically adjusted.
When turning ON: The laser beam brightness is adjusted by performing
brightness tuning. When OFF is switched to ON, the brightness tuning setting
window is displayed.

2 - Clicking this button displays the brightness tuning setting window. Brightness of
laser beams is adjusted using two measured objects.

5.2.1 Brightness Tuning

This section explains how to perform brightness tuning.

1. Click the "Brightness Tuning" button with "OFF" selected to change the setting to "ON" or
click the [Brightness Tuning] button.

2. The "Brightness Tuning" dialog box will be displayed. Prepare two workpieces that differ in
brightness. Mount the first workpiece and then click the [Register the amount of beam
emission] button. "Registering" will be displayed.

3. If the amount of beam emission is successfully registered using the first workpiece, the
amount of beam emission can be registered using the second workpiece. Mount the second
workpiece and then click the[Register the amount of beam emission]button."Registering"will
be displayed.

5.2 Adjusting Sensitivity
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4. If the amount of beam emission is successfully registered using the second workpiece,
brightness tuning will be completed. If "Brightness Tuning" is OFF, it will be switched to ON.
To perform brightness tuning again, click the [Brightness tuning] button and then perform
Step 2 onward.

● If, after the first workpiece is registered, brightness tuning is canceled, the "Brightness
Tuning" will be switched to OFF.

● If brightness tuning fails, the message"Brightness tuning failed. Check the condition of the
sensor or communication."will be displayed. Check whether any of the following causes is
applicable, and then perform brightness tuning again.
• The sensor is in an alarm state.
• The measured value is in an indeterminate state.
• Hold mode is set to anything other than"None".
• Trigger input is set to"ON".
• Laser Stop is in"ON"state.

5.2 Adjusting Sensitivity
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5.3 Configuring Measurement Settings

The following window allows the user to set the inversion of measured value in the positive or
negative direction, sampling cycle, and average count according to the shape of the measured
object or application.

Name Description

1
Inversion of
Measured Value(Note

1)

ON: Implements a mirror inversion of the measured value at 0 mm as its base
OFF: Displays measured values as normal

2 Sampling period This drop-down list allows the user to set a desired sampling cycle according to the
moving speed of the workpiece.

3 Average Times This drop-down list allows the user to set a moving average count. When measured
values are unstable, they can be stabilized by increasing the average count.

 

(Note 1) When configuring the sensor unit, "±Inversion" is displayed.
 

5.3 Configuring Measurement Settings
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5.4 Configuring Correction Settings

The following window allows the user to specify how to correct and hold measured values
according to the shape of the measured object or application.

Name Description

1 Span This field is used to set a span (coefficient) that multiplies the measured value.

2 Offset This field is used to set an offset correction value that is added to the measured
value.

3 Zero Setting Clicking this button sets or cancels a zero setting correction value that assumes the
current measured value as"zero".

4 Hold Mode This drop-down list allows the user to select how to hold measured values
according to the measurement method for detected objects.

5 Trigger Mode This option allows the user to select a hold setting method when trigger input is ON
or OFF.

● Clicking the[Zero Setting]button displays the"Zero Set Setting"dialog box.

Clicking the[Zero Setting]button in the"Zero Set Setting"dialog box sets a zero setting
correction value that assumes the current measured value as zero. Clicking the[Clear]button
clears the set zero setting correction value.

5.4 Configuring Correction Settings
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5.5 Configuring Operation Settings

The following window allows the user to set thresholds, digital output, and alarms.

(Note 2)

Name Description

1 HIGH Set Value This field is used to set an upper threshold value.

2 LOW Set Value This field is used to set a lower threshold value.

3 Teaching
Clicking this button performs teaching that sets HIGH and LOW set values.
For details, refer to"5.5.1 Teaching".

4 Hysteresis This field is used to set a hysteresis value.

5 Timer Select
This drop-down list allows the user to set control output timing.
For details, refer to"5.5.2 Configuring digital output settings".

6 Timer Setting(Note 1) This field is used to set a timer time value.
For details, refer to"5.5.2 Configuring digital output settings".

7 Alarm Delay Count
This field is used to set the number of delays that triggers notification output when
an alarm state is detected.
For details, refer to"5.5.3 Configuring alarm settings".

8 Alarm Digital Output
This field is used to set an output method to be used when an alarm state is
detected.
For details, refer to"5.5.3 Configuring alarm settings".

 

(Note 1) "Timer Setting" can be set when "On Delay", "Off Delay", or "One Shot" is selected in the "Timer
selection" drop-down list.

(Note 2) For the setting range and set value conditions of each parameter, refer to theHL-G2 Series User’s
Manual (Communication Type).

 

5.5 Configuring Operation Settings
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5.5.1 Teaching

Using the teaching function enables LOW and HIGH set values to be set automatically. Select a
desired teaching method from "1-point teaching", "2-point teaching", and "3-point teaching".

Name Description Reference section

1-point teaching
This method determines a LOW set value and HIGH set value
according to the measured value and tolerance setting of the
master workpiece.

"1-point teaching"

2-point teaching
This method determines a LOW set value and HIGH set value by
using two types of workpiece that are used as LOW reference and
HIGH reference.

"2-point teaching"

3-point teaching
This method determines a LOW set value and HIGH set value by
using three types of workpiece that are used as LOW reference,
GO reference, and HIGH reference.

"3-point teaching"

1-point teaching

This section explains how to set a LOW set value and HIGH set value by using a master
workpiece.

1. Select"1-point teaching"from the drop-down list.

2. Enter a tolerance (±) to be set.

3. With the master workpiece measured, click the[Fix measured value]button. Set"HIGH Set
Value"for a fixed measured value to which the tolerance is added and"LOW Set Value"for a
fixed measured value from which the tolerance is subtracted.

5.5 Configuring Operation Settings
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● Be sure to set "Tolerance" to a value larger than "Hysteresis".
● After fixing the measured value, you can manually correct the respective values of"HIGH

Set Value"and"LOW Set Value".
● Clicking the[Clear]button restarts updating the measured value.
● Clicking the[Reset]button restores the tolerance to its default value and restarts updating

the measured value.

4. Click the[Use]button to apply the teaching results to the configuration parameters.

2-point teaching

This section explains how to set a LOW set value and HIGH set value by using target
workpieces.

1. Select "2-point teaching" from the drop-down list.

2. Measure a workpiece and click the [Fix measured value] button in the "First workpiece"
section.

3. Measure another workpiece and click the [Fix measured value] button in the "Second
workpiece" section. Set the larger one of the two measured values as "HIGH Set Value"
and the smaller one as "LOW Set Value".

5.5 Configuring Operation Settings
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● After fixing the measured value, you can manually correct the respective values of "HIGH
Set Value" and "LOW Set Value".

● Clicking the [Clear] button for each workpiece restarts updating the measured value for that
workpiece.

● Clicking the [Reset] button restarts updating the measured values for both workpieces.

4. Click the [Use] button to apply the teaching results to the configuration parameters.

3-point teaching

This section explains how to set a LOW set value and HIGH set value by using three types of
workpiece.

1. Select "3-point teaching" from the drop-down list.

2. Measure a workpiece to be used as HIGH reference and click the [Fix measured value]
button in the "First workpiece" section.

3. Measure a workpiece to be used as GO reference and click the [Fix measured value] button
in the "Second workpiece" section.

5.5 Configuring Operation Settings
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4. Measure a workpiece to be used as LOW reference and click the [Fix measured value]
button in the "Third workpiece" section.

Under the following conditions, set "HIGH Set Value" and "LOW Set Value".
● HIGH Set Value = (Measured value of first workpiece + Measured value of second

workpiece)/2
● LOW Set Value = (Measured value of second workpiece + Measured value of third

workpiece)/2

● After fixing the measured value, you can manually correct the respective values of "HIGH
Set Value" and "LOW Set Value".

● Clicking the [Clear] button for each workpiece restarts updating the measured value for that
workpiece.

● Clicking the [Reset] button restarts updating the measured values for all workpieces.

5. Click the [Use] button to apply the teaching results to the configuration parameters.

5.5.2 Configuring digital output settings

You can set control output timing and a timer time value. From the "Timer Select" drop-down
list, select one of the timer setting methods shown in the table below.

Setting item Operation

OFF (No timer) No change is made in the control output timing.

On Delay When control output is switched from OFF to ON, ON output is delayed by the specified
timer time value.

Off Delay When control output is switched from ON to OFF, OFF output is delayed by the specified
timer time value.

One Shot When control output is switched from OFF to ON, ON is held for the specified timer time
value and then OFF is output.

Hold Output signals are held from when an object is detected until measured value reset input
turns ON.

5.5 Configuring Operation Settings
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"Timer Setting" can be set when "On Delay", "Off Delay", or "One Shot" is selected in the "Timer
selection" drop-down list.

● The setting range for "Timer Setting" is 1 ms to 100 ms.
● The set timer time value is shared by all timer settings.

5.5.3 Configuring alarm settings

You can set a delay count at alarm occurrence and an alarm output method.
From the"Alarm Delay Count"item, set the number of delays that triggers notification output
when an alarm state is detected.

● The setting range for "Alarm Delay Count" is from 0 to 65535.
From the"Alarm Digital Output"item, set an output method to be used when an alarm state is
detected.

Setting item Operation

Alarm The measured value is hidden. In the display section of the sensor, "ALARM" is
displayed.

Hold previous value Holds and displays a value that is measured immediately before an alarm state is
detected

5.5 Configuring Operation Settings
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5.6 Performing Configuration

You can set banks to/from which measurement conditions or judgment criteria are written or
read, a display method for the main display section, and key lock.

Name Description

1 Item to be read and
written This drop-down list allows the user to set items to be written to or read from banks.

2 Bank operation Clicking this button allows the user to select a bank and write or read data to/from
the bank.

3 Display Digit This drop-down list allows the user to set the number of digits after the decimal
point in the main display section.

4 ECO Mode
ON: Turns OFF the main display section unless keys are operated
OFF: Turns ON the main display section at all times

5 Display Inversion
ON: Displays the main display section upside down
OFF: Displays the main display section as normal

6 KEY LOCK
ON: Disables key operation
OFF: Enables key operation as normal

7 Language This option allows the user to select a display language to be used in the main
display section.

5.6.1 Bank operation

This section explains how to write and read data to/from banks.

1. Check whether the correct item is selected in the "Item to be read and written" drop-down
list and then click the [Bank operation] button.

5.6 Performing Configuration
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2. Select a target bank (1 to 4).

3. Click [Write] to write data to the bank or [Read] to read data from the bank.

4. A confirmation dialog box will be displayed. Clicking [Yes] executes write or read
processing.

5.6 Performing Configuration
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6.1 Configuring IP Settings

The "Device information" tab allows the user to change IP settings for the sensor and PC.

Name Description

1 IP settings This area displays the IP settings configured for the sensor.

2 [Writing IP settings] button
Clicking this button writes the changed IP settings to the sensor.
For details on how to change IP settings for sensors, refer to
"6.1.1 Configuring sensor IP settings".

3 [PC IP settings] button
Clicking this button displays the IP settings configured on the PC.
The IP settings on the PC can also be changed. For details, refer to
"6.1.2 IP settings for PC".

The default values of each IP setting item are shown below.
IP address: 192.168.1.6
Subnet mask: 255.255.255.0
Default gateway: 192.168.1.1
Port No.(Tool): 49152
Port No.(Modbus): 502

6.1.1 Configuring sensor IP settings

This section explains how to change IP settings for sensors.

1. In the "Device list" window, select a sensor for which IP settings are to be changed.

6.1 Configuring IP Settings
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2. Make the necessary change to the IP settings for the sensor.

3. Click the [Writing IP settings] button.

4. A confirmation message will be displayed. Clicking [Yes] applies the change to the IP
settings for the sensor.

If writing the IP settings has failed, check whether any of the following causes is applicable.
● An error has occurred on the sensor or communication.
● The default gateway does not exist in the same network segment (subnet) as the one

defined by the IP address and subnet mask.
● The IP address or default gateway is set to 0.0.0.1- 0.255.255.255,

127.0.0.0-127.255.255.255, or 224.0.0.0-224.255.255.255.
● All bits in the host address segment of the IP address or default gateway are set to 0.
● All bits in the host address segment of the IP address or default gateway are set to 1.
● The subnet mask does not consist of consecutive bits.
● The port number is identical with the port number for Modbus.
● The port number is 44818.

6.1.2 IP settings for PC

This section explains how to change IP settings for PC.

1. Click the [PC IP settings] button.

6.1 Configuring IP Settings
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2. Make the necessary changes to the settings in the "PC IP settings" window.

3. Click [OK].

4. A confirmation message will be displayed. Clicking [Yes] applies the change to the IP
settings for the PC.

● The "User Account Control" confirmation window may be displayed. In such a case, click
[Yes] to proceed with the change procedure.

6.1 Configuring IP Settings
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6.2 Configuring SLMP Settings

This section explains how to change SLMP settings.

1. Select the"Device information"tab and click the[SLMP settings]button to display the"SLMP
settings"window.

2. Change the SLMP settings. For details on the setting items, refer to the following sections.
"6.2.1 Client communication setting"
"6.2.2 Client transmission data setting"
"6.2.3 Client data transmission"
"6.2.4 Server communication settings"

3. Clicking[Write]writes the changed settings to the sensor.

● If there is any problem with the sensor being configured or the communication status, you
will be exited from the configuration with a warning message.

● Clicking[Write]writes all the changed information including the information changed in tabs
other than the selected tab to the sensor.

6.2 Configuring SLMP Settings
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6.2.1 Client communication setting

The following window allows the user to check and change communication settings for sensors
(clients).

Name Description

1 Communication settings These items are used to set communication parameters for the client.

2 Write interval(Note 1) This field is used to set an interval at which data is written to the server.

3 Automatic writing after starting
ON: Starts writing data automatically after startup
OFF: Starts writing data at any desired timing

 

(Note 1) The setting range of "Write interval" is 50 ms to 10000 ms (in increments of 10 ms). The default value
is 500 ms.

 

The setting range and default value of each communication setting parameter are shown below.

Parameter name Setting range Default value

Request destination IP
address

0.0.0.1 to 255,255,255,255 192.168.1.100

Request destination port
No.

1 to 65535 45237

Request destination
processor number

0x03FF: Default processor
0x03D0: Control system processor
0x03D1: Standby system processor
0x03D2: A-system processor
0x03D3: B-system processor
0x03E0: Multiprocessor 1
0x03E1: Multiprocessor 2
0x03E2: Multiprocessor 3
0x03E3: Multiprocessor 4

0x03FF: Default processor

Request destination network
number

0, 1-239 0

Request destination station
number

When "Request destination network
number" is "0": "255" 255(Note 1)

6.2 Configuring SLMP Settings
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Parameter name Setting range Default value
When "Request destination network
number" is "1-239": "1-120", "125", "126"

Request source port No. 1 to 65535 45238
 

(Note 1) When "Request destination network number" is "1-239", the default value is "1-120".
 

6.2.2 Client transmission data setting

The following window allows the user to check and change settings for data transmission from
sensors (clients).

Name Description

1 Starting register No. This filed is used to set a starting register number.

2 Ending register No. An ending register number is automatically set according to the starting register
number and transmission parameter settings.

3 Transmission
parameter This area allows the user to select a type of parameters to be written.

6.2.3 Client data transmission

Data can be sent from a sensor (client) to its host device (server).

6.2 Configuring SLMP Settings
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Name Description

1 Data transmitting
state

This item indicates the current data transmission state.
"Writing suspended": Indicates the state in which "Automatic writing after starting"
is set to OFF and writing is suspended
"Writing in progress": Indicates the state in which "Automatic writing after starting"
is set to OFF and writing is in progress
"Automatic writing in progress": Indicates the state in which "Automatic writing
after starting" is set to ON and writing is in progress

2 [Remote RUN]button Clicking this button starts writing when writing is suspended.

3 [Remote
STOP]button Clicking this button stops writing when writing is in progress.

6.2.4 Server communication settings

The following window allows the user to check and change the main unit settings when the HL-
G2 is used as a server.

6.2 Configuring SLMP Settings
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Name Description

1 Communication
settings This window allows the user to set up communication parameters for the server.

The setting range and default value of each communication setting parameter are shown below.

Parameter name Setting range Default value

Port No. 1 to 65535(Note 1) 45237

Network No. 0, 1-239 0

Node No.
When "Network No." is"0":"255"
When "Network No." is"1-239":"1-120","125","126". 255(Note 2)

 

(Note 1) "2222","9090","44818", and the port No. used for the client function cannot be set.
(Note 2) When "Network No." is"1-239", the default value is"1-120".
 

6.2 Configuring SLMP Settings
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7.1 Monitoring Multiple Sensors

This section explains how to use the "Multimonitor" function, which monitors multiple sensors in
the Monitor window.

1. Select "Multimonitor" in the "Device list" window.

2. Drag multiple sensors to be monitored simultaneously and drop them into the "Monitor" tab.

3. The received light intensities and measured values of each sensor that was dragged and
dropped will be displayed.

7.1 Monitoring Multiple Sensors
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● The Multimonitor function can monitor and display up to eight sensors.
● The Multimonitor function cannot log measured values for serial communication type

sensors.
● To remove a sensor from the Multimonitor function, click the recycle bin icon on the right

side of the sensor.

7.1 Monitoring Multiple Sensors

WUME-HLG2CT-1 7-3



7.1.1 Multimonitor display window

■ Multimonitor for received light intensity waveforms

Name Description

1 Legend This is a list of monitored sensors. Sensors are displayed in the order in which they
are shown in the "Device list" window.

2 Show/hide check box Graphs are displayed for sensors for which the check box is selected. Graphs are
not displayed for sensors for which the check box is canceled.

3 Line color Display color of graph line

4 Sensor information Serial number and label of sensor

5 Peak value Maximum value of received light intensity waveforms

6 Peak cell Cell position of peak value

7 [Delete legend]button Clicking this button removes the sensor from the legend.

8 Received light
intensity waveform This graph is drawn by plotting received light intensities and cell positions.

9
Export as Image
Data output

Use these buttons to output received light intensity waveforms to a file. Clicking the
"Data output" button outputs all graphs of the sensors for which the show/hide
check box is selected. For details, refer to"4.5.3 Export as Image / Data output".

7.1 Monitoring Multiple Sensors
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■ Multimonitoring measured values

Name Description

1 Legend This is a list of monitored sensors. Sensors are displayed in the order in which they
are shown in the "Device list" window.

2 Show/hide check box Graphs are displayed for sensors for which the check box is selected. Graphs are
not displayed for sensors for which the check box is canceled.

3 Line color Display color of graph line

4 Sensor information Serial number and label of sensor

5 Output state This section indicates the output state of the sensor. For details, refer
to"4.4.3 Output state".

6 [Delete legend]button Clicking this button removes the sensor from the legend.

7 Measured value
graph

This graph is drawn by plotting measured values and elapsed time. The display
area can be zoomed in or zoomed out by rotating the mouse wheel while the
mouse pointer is within the display area. The display area can also be zoomed in or
zoomed out at low speed by rotating the mouse wheel while holding down
the<Ctrl>key.

8 Slider This slider allows the user to change the display range of measured value graphs.

9
[Start]button
[Pause]button
[Resume]button

This button allows the user to perform logging to continue collecting measured
values in any desired time cycle.
● Clicking the "Start" button before the start of logging starts logging. The button

display will be changed as follows:Start>Pause.
● Clicking the "Pause" button during logging pauses logging. The button display

will be changed as follows:Pause>Resume.(Note 2)

● Clicking the "Resume" button during paused logging resumes logging. The
button display will be changed as follows:Resume>Pause.

7.1 Monitoring Multiple Sensors
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Name Description

10 [Clear]button
This button allows the user to erase logged results. If you click the[Clear]button and
then[Yes]in the confirmation message window, you can erase the logged results
and start new logging.

11 Data cycle

This section indicates the time cycle in which measured values are to be collected
by logging.
The minimum settable value is 10 ms and the maximum settable value is 400 ms.
(Note 3)

12
Export as Image
Data output

Use these buttons to output the measured values that have been logged to a file.
Clicking the "Data output" button outputs all graphs of the sensors for which the
show/hide check box is selected. For details, refer to"4.5.3 Export as Image / Data
output".

 

(Note 1) The maximum allowable number of measurement times per logging is 60,000.
(Note 2) Logged data is not saved at the time of pause. For details on how to save logged data, refer

to"4.5.3 Export as Image / Data output".
(Note 3) By default, the data cycle is set to 200 ms.
 

7.1 Monitoring Multiple Sensors
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7.2 Setting Labels to Sensors

This section explains how to set label names to identify each sensor easily.

1. In the "Device list" window, select a sensor for which a label is to be set and click the
"Device information" button.

2. In the "Label" field, enter any desired label name.

● The maximum number of characters for a label name is 30.

3. After entering a label name, press the <Enter> key. A confirmation message will be
displayed. Click [Yes].

4. The entered label name will be displayed in any window where labels are displayed.

7.2 Setting Labels to Sensors
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7.3 Configuring Settings Offline

Sensor settings can be configured using HL-G2 Configuration Tool even if the PC does not
communicate with the sensor (offline).

7.3.1 Creating a new configuration file

This section explains how to create a new configuration file.

● If a sensor has been added to the "Device list" window, a confirmation message will be
displayed, asking whether to save the configuration file. If you must save the
configuration file, click [Yes]. If you click [No], the changed settings will be discarded.

1. On the menu bar, select File>New. Alternatively, select "Create a new file" in the "Start
menu" window displayed when HL-G2 Configuration Tool is started, and then click [Start].

2. The "Add sensors" window will be displayed. Select a desired sensor and click [Add]. The
selected sensor will be added to the "Device list" window. Clicking [Cancel] empties the
"Device list" window.

7.3 Configuring Settings Offline
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● For details on how to add more sensors, refer to "4.4.4 Adding sensors".

7.3.2 Opening a configuration file

This section explains how to open a saved configuration file in HL-G2 Configuration Tool.

● If a sensor has been added to the "Device list" window, a confirmation message will be
displayed, asking whether to save the configuration file. If you must save the
configuration file, click [Yes]. If you click [No], the changed settings will be discarded.

1. On the menu bar, select File>Open. Alternatively, select "Open a file" in the "Start menu"
window displayed when HL-G2 Configuration Tool is started, and then click [Start].

2. Select a saved configuration file and open it.

● When a configuration file is opened, each sensor in the "Device list" window enters the
"Disconnection" state.

7.3.3 Writing settings configured offline

This section explains how to write settings configured or edited offline to a sensor.

1. In the "Device list" window, click the [Connection] button for the sensor to which settings are
to be written.

7.3 Configuring Settings Offline
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2. Connected sensors will be displayed. Select the sensor to which settings are to be written
and then click [Finalize].

● You cannot select a sensor whose model does not agree with the settings.

3. A confirmation message will be displayed, asking whether to write the settings. Click [Yes].

4. The settings will be written to the sensor, which will then enter a connection state.

7.3 Configuring Settings Offline
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7.4 Copying Settings

This section explains how to copy settings configured for one sensor to apply them to another
sensor.

1. In the "Device list" window, select a sensor from which settings are to be copied.

2. Copy settings using one of the following methods.
● Shortcut keys: Press the <Ctrl>+<C> keys.
● Right-click and then select [Copy] from the context menu that appears.
● On the menu bar, select Edit>Copy.
● Click the [Copy] icon on the Quick Access Toolbar.
The sensor from which settings are being copied will be surrounded by a dotted line frame.

For details on how to apply copied sensor settings to another sensor, refer to "7.4.1 Pasting
settings" or "7.4.2 Selecting and pasting settings".

● The following settings cannot be copied.
• Brightness tuning settings
• Zero setting correction value
• Bank settings

7.4 Copying Settings
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7.4.1 Pasting settings

This section explains how to apply (paste) copied settings to another sensor.

1. In the "Device list" window, select a sensor to which copied settings are to be applied.

2. Paste settings using one of the following methods.
● Shortcut keys: Press the <Ctrl>+< V> keys.
● Right-click and then select [Paste] from the context menu that appears.
● On the menu bar, select Edit>Paste.
● Click the [Paste] icon on the Quick Access Toolbar.

3. Copied sensor settings will be applied to the selected sensor.

● If there is any problem with settings, a message will be displayed and settings cannot be
pasted. In such a case, correct the problem indicated by the message.

● If the model of the sensor from which settings are copied differs from the model of the
sensor to which the settings are pasted, some settings may fall outside the scope of paste
processing. In such a case, a message will be displayed, indicating parameters that cannot
be applied, and only parameters that can be applied will be pasted.

7.4.2 Selecting and pasting settings

This section explains how to apply (paste) only the specified copied settings to another sensor.

1. In the "Device list" window, select a sensor to which copied settings are to be applied.

7.4 Copying Settings
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2. Open the "Select and Paste" window using one of the following methods.
● Shortcut keys: Press the <Ctrl>+<Alt>+<V> keys.
● Right-click and then select [Select and Paste] from the context menu that appears.
● On the menu bar, select Edit>Select and Paste.
● Click the [Select and Paste] icon on the Quick Access Toolbar.

Name Description

1 Copy source This section indicates the label of the sensor selected as the copy source of the
settings.

2 Items to be pasted Select the check boxes of setting items to be pasted.

3
"Specify several
paste destinations"
check box

Selecting this check box allows the user to select more than one sensor as
paste destinations.

4 Paste destination
sensors

Paste destination sensors are displayed when the "Specify several paste
destinations" check box is selected. Select the check boxes of paste destination
sensors.

5 "Select all" check
box

Selecting this check box selects all the check boxes in the "Items to be pasted"
or "Paste destination sensors" section. Canceling this check boxes cancels all
the check boxes in the "Items to be pasted" or "Paste destination sensors"
section.

7.4 Copying Settings
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Name Description

6 [Paste] button Clicking this button pastes all the setting items corresponding to the selected
check boxes in the "Items to be pasted" section.

3. Select desired check boxes in the "Items to be pasted" section and "Paste destination
sensors" section, and click [Paste]. Only the specified setting items among those copied
from the source sensor will be applied to the selected sensor.

7.4 Copying Settings
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7.5 Comparing Settings

This section explains how to compare the settings of two sensors displayed in the "Device list"
window and check for any differences in settings.

1. Open the"Select settings to be collated"window using one of the following methods.
● On the menu bar, selectEdit>Settings collation.
● Click the[Settings collation]icon on the Quick Access Toolbar.

2. Select two sensors whose settings are to be compared.

● When the"Select settings to be collated"window is displayed, the sensor selected in the
"Device list" window is automatically selected as the first sensor.

● Selecting a sensor that is connected online displays a confirmation dialog box, asking
whether to load the sensor settings.
• Click [Yes] to compare the settings in the "Settings" tab by overwriting them with the

sensor settings.
• Click [No] to compare the settings in the "Settings" tab as they are.

3. Click[Settings collation].

7.5 Comparing Settings
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4. The settings of the two sensors will be displayed side by side. The cells with any difference
in settings will be highlighted in blue.

7.5 Comparing Settings
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7.6 Protecting Settings

Selecting the "Enable write lock function" check box allows the user to specify a password that
is required to write settings to a sensor. Specifying a password prevents third parties who do
not know the password from setting and changing any functions for the sensor.

● Strictly manage passwords to prevent set passwords from being forgotten or leaked to
third parties.

7.6.1 Setting a password

This section explains how to protect sensor settings with a password by selecting the"Enable
write lock function"check box.

1. On the menu bar, selectFile>Option.

2. Select the"Enable write lock function"check box.

3. Select the"Set a new password"check box and then enter values in the"Current
password"and"New password"fields. When setting a password for the first time, enter a
new password only.

7.6 Protecting Settings
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● The number of characters that can be set as a password is fixed at four single-byte
characters.

● The following characters can be used for passwords.
• Uppercase and lowercase letters (case-sensitive)
• Numerical characters
• Symbols: ! " # $ % & ' ( ) - ^ \ @ [ ; : ] , . / = ~ | ` { + * } < > ? _
• Space

● We recommend that you set a secure password, which is a combination of four types of
characters: uppercase letters, lowercase letters, numerical characters, and symbols
(including space).

4. For confirmation, enter the same password in the"New password (confirm)"field.

5. Click[OK].

7.6.2 Canceling a password

This section explains how to cancel a password to enable writing to the sensor.

7.6 Protecting Settings
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1. On the menu bar, select File>Option.

2. Cancel the "Enable write lock function" check box.

3. Enter the password and click [OK].

7.6.3 Initializing a password

This section explains how to initialize a password in case you have forgotten your password.

1. In the "Password entry" window, click [Initialization].

2. The "Password initialization" dialog box will be displayed. Notify your local dealer of the
code displayed in the "Request code" field. Your local dealer will notify you of a code to be
entered in the "Initialization code" field.

7.6 Protecting Settings
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3. Enter the code in the "Initialization code" field.

4. Click [Initialization]. The write lock function will be canceled and no password will be set for
the sensor.

7.6 Protecting Settings
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7.7 Initializing Settings

You can initialize sensor settings and banks. For details on contents that can be initialized in
each operation, refer to the HL-G2 Series User’s Manual (Communication Type).

7.7.1 Initialize Sensor

This section explains how to restore sensor settings to the default settings.

1. In the "Device list" window, select a sensor for which settings are to be initialized and click
the"Device information"tab.

2. Click the[Initialize sensor]button.

3. A confirmation dialog box will be displayed. Clicking[Yes]displays a confirmation dialog box,
asking whether to save the settings.

● Unless you save the settings, the sensor cannot be restored to the state prior to
initialization. We recommend that settings be saved before initialization.

4. Click [Yes] to save the settings or [No] to restore the sensor settings to the default settings.

7.7 Initializing Settings
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7.7.2 Initialize Bank

This section explains how to initialize banks.

1. In the "Device list" window, select a sensor for which banks are to be initialized and click the
"Device information" tab.

2. Click the [Initialize Bank] button.

3. Select a target bank to be initialized or "All Banks".

4. Clicking [Initialization] displays a confirmation dialog box. Clicking [Yes] initializes the
selected bank.

7.7 Initializing Settings
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8.1 Error Messages and Action Methods

If an error occurs during setup or measurement, icons and the number of occurrences will be
displayed in the "Device list" window. Clicking on the product image displays details of the error.

Error code Description Action method

E100**
Dark level adjustment error Install the sensor so that strong light or

fluctuating light does not enter the sensor, and
turn the power OFF and then ON.

E110** Communication start processing error Turn the power OFF and then ON.

E120** CPU error Turn the power OFF and then ON.

E130** Internal memory access error (system area) Turn the power OFF and then ON.

E131** Internal memory access error (user area) Perform the procedure described
in"7.7.1 Initialize Sensor".

E140** Internal access error Turn the power OFF and then ON.

E150** Startup processing error Turn the power OFF and then ON.

E200** Beam-emitting circuit error We recommend that the sensor be replaced.
 

(Note 1) The error code is displayed in 6 digits. Check the contents of error by referring to the first 4 digits of
the error code.

 

● When an error has occurred, check whether the sensor is subject to excessive vibration.
● If the sensor still does not operate normally even after you have taken action as above,

consult your local dealer.

8.1 Error Messages and Action Methods
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8.2 Alarm Messages and Action Methods

If alarm conditions are satisfied during setup or measurement, icons and the number of
occurrences will be displayed in the "Device list" window. Clicking on the product image
displays details of the alarm.

Alarm message Action method

Alarm indicating excessive
received light intensity

The intensity of received light is too much. Adjust the position and angle of the
sensor.

Alarm indicating excessive
extraneous light

The intensity of received light is too much. Check if extraneous light hits the light
receiving section of the sensor.

Alarm indicating
inadequate received light
intensity

The received light intensity is insufficient. Adjust the sensor position and remove
any stain or shielding objects.

● If the sensor still does not operate normally even after you have taken action as above,
consult your local dealer.

8.2 Alarm Messages and Action Methods
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